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1. Operating System Requirements

 XE "Operating System Requirements" This chapter defines the minimal hardware and operating system configuration under which a VistA GUI application must be able to function properly and adequately. As a policy, the minimal hardware/operating system configuration will be reviewed annually to ensure software performance would not be hindered by obsolete equipment/Operating Systems.

1.1. Client Operating System XE "Client Operating System" 
All VistA GUI applications will run on the Microsoft NT operating system.

1.2. Client Hardware Requirements XE "Client Hardware Requirements" 
All VistA GUI applications will run on systems that meet the following specifications:

1.2.1. CPU XE "CPU"  – Pentium Pro 200MHz or equivalent

1.2.2. RAM XE "RAM"  – 128 MB

1.2.3. Graphics Resolution XE "Graphics Resolution"  – VGA 800 x 600, 256 colors

(The VistA Imaging software is granted an exemption.)

1.2.4. A keyboard and mouse
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2. Namespacing

 XE "Namespacing" VistA application namespace assignments XE "Namespace Assignments:VistA Applications"  include application folder names, executable file names, nationally supported component class names, registry names, common files, documentation files, help files, and palette tabs. Registering nationally distributed namespaced items with the DBA XE "Data Base Administrator (DBA)"  will prevent them from overwriting items of the same name.

2.1. Data Base Administrator XE "Data Base Administrator (DBA)" 
2.1.1. The Data Base Administrator (DBA) XE "Data Base Administrator (DBA)"  shall be the responsible authority for all namespace assignments XE "Namespace Assignments:DBA Authority" .

2.2. Application Folder Namespace Assignment XE "Application Folder:Namespace Assignment" 

 XE "Namespace Assignments:Application Folder" 
2.2.1. All files for a VistA application, with the exception of common files, shall be placed in an application folder under the VistA folder XE "VistA folder" . The pathway shall be Drive:\Program Files\VISTA\application folder namespace.

Example: C:\Program Files\VISTA\NOIS

2.2.2. The VistA application shall use the folder namespace assigned by the DBA XE "Data Base Administrator (DBA)" .

2.3. Executable File Namespace Assignment XE "Executable File:Namespace Assignment" 

 XE "Namespace Assignments:Executable Files" 
2.3.1. Installation executable file XE "Installation Executable File" 

 XE "Executable File:Installation"  names shall begin with the namespace assigned to the application by the DBA XE "Data Base Administrator (DBA)" .

2.3.2. Application (non-installation) executable file XE "Application (Non-installation) Executable File"  names shall begin with the namespace assigned to the application by the DBA XE "Data Base Administrator (DBA)" .

2.4. Nationally Supported Component Classes Namespace Assignment XE "Nationally Supported Component Classes:Namespace Assignment" 

 XE "Namespace Assignments:Component Classes" 

 XE "Component Classes:Namespace Assignment" 
2.4.1. Delphi component classes XE "Delphi:Component Classes" 

 XE "Component Classes:Delphi"  shall begin with a "T" followed by the namespace (e.g., TORListBox where "OR" is the namespace).

2.4.1.1. For programming languages other than Delphi XE "Programming Languages Other Than Delphi Namespacing" 

 XE "Namespacing:Programming Languages Component Classes Other Than Delphi" 

 XE "Component Classes:Namespacing in Programming Languages Other Than Delphi" , the names of the component classes developed in those languages shall include the namespace assigned to the application while allowing for the conventions for the programming language (e.g., "C" followed by the namespace for Java).

2.4.2. Nationally supported component classes XE "Nationally Supported Component Classes" 

 XE "Component Classes:Documenting"  shall be documented in a Data Base Integration Agreement (IA) XE "Data Base Integration Agreement (IA)"  on FORUM. The IA USAGE XE "IA USAGE"  value shall be SUPPORTED.

2.5. Windows Registry XE "Windows Registry" 
2.5.1. All VistA software shall use the Windows Registry to only store workstation-specific information. All user- and application-specific state information XE "State Information, Windows Registry" 

 XE "Windows Registry:State Information"  shall be stored on the server.

2.5.2. VistA software shall not use initialization files XE "Initialization Files (.ini)"  (i.e., .ini).

2.5.3. When a VistA application needs to make or modify entries at run time in a Windows registry, it shall use the following pathway:

HKEY_CURRENT_USER XE "HKEY_CURRENT_USER" \SOFTWARE\VISTA\application folder namespace

Example: HKEY_CURRENT_USER\SOFTWARE\VISTA\NOIS

Applications shall have the ability to add subfolders on this pathway at their discretion

Example: HKEY_CURRENT_USER\SOFTWARE\VISTA\NOIS\VERSION 1.0

2.5.4. When a VistA application needs to make or modify entries during installation in a Windows registry, it shall use the following pathway:

HKEY_LOCAL_MACHINE XE "HKEY_LOCAL_MACHINE" \SOFTWARE\VISTA\application folder namespace

Example: HKEY_LOCAL_MACHINE\SOFTWARE\VISTA\NOIS 
Applications shall have the ability to add subfolders on this pathway at their discretion

Example: HKEY_LOCAL_MACHINE\SOFTWARE\VISTA\NOIS\VERSION 1.0

2.6. "Common Files" Folder Namespace Assignment XE "Common Files:Folder Namespace Assignment" 

 XE "Namespace Assignments:Common Files" 
2.6.1. A "Common Files XE "Common Files" " folder shall exist under the VistA folder. The pathway shall be Drive:\Program Files\VISTA\Common Files.

2.6.2. Files that are supported for use by more than one application shall be placed in the "Common Files" folder. For example, .dll XE "DLL Files" 

 XE "Dynamic Link Libraries" , .bpl XE "BPL Files" 

 XE "Compiled Packages" , and .ocx XE "OCX Files"  files that are supported for use by more than one application shall be placed in the "Common Files" folder.

2.6.3. The file names in the "Common Files XE "Common Files" " folder shall begin with the namespace.

2.6.4. All files in the "Common Files XE "Common Files" " folder shall be documented in a Data Base Integration Agreement (IA) XE "Data Base Integration Agreement (IA)"  on FORUM. The IA USAGE XE "IA USAGE"  value shall be SUPPORTED.

2.7. Documentation Files Namespace Assignment XE "Documentation Files:Namespace Assignment" 

 XE "Namespace Assignments:Documentation Files" 
2.7.1. All documentation files shall be namespaced regardless of their location.

2.7.2. All documentation files shall be named in the same manner as existing VistA documentation such as User Manual files (i.e., Namespace, version XE "Version Number:Documentation File Names" , [patch number XE "Patch Numbers:Documentation File Names" , if applicable], document type XE "Documentation Type:Documentation File Names" , and file type XE "File Type:Documentation File Names" ).

For example, a new version of an application is released. The package namespace is ABCD, the version number is 1.0, the document type is a ReadMe file and the file type is a text file. The documentation file name shall be: ABCD1_ReadMe.txt.

If patch number 1 has a ReadMe file that documentation file name shall be: ABCD1_P1_ReadMe.txt.

2.8. Help Files Namespace Assignment XE "Help Files:Namespace Assignment" 

 XE "Namespace Assignments:Help Files" 
2.8.1. All help files shall be namespaced regardless of their location.

2.9. Palette Tabs Namespace Assignment XE "Palette Tabs:Namespace Assignment" 

 XE "Namespace Assignments:Palette Tabs" 

 XE "Delphi:Palette Tabs Namespace Assignment" 
2.9.1. Palette tabs that are added to the development environment shall use the namespace of the application folder.

2.9.2. Applications that wish to place their nationally supported component classes XE "Nationally Supported Component Classes" 

 XE "Component Classes:Delphi Palette Tabs"  under a different tab shall document the new location in a Data Base Integration Agreement (IA) on FORUM XE "Data Base Integration Agreement (IA)" . The IA USAGE XE "IA USAGE" 

 XE "Component Classes:Documenting"  value shall be SUPPORTED.

3. Release of Software

3.1. Version Identification XE "Version Identification" 

 XE "Version Number:Identification" 

 XE "Version Identification" 
 XE "Release of Software" 

 XE "Software Release" An industry standard type sequential version number XE "Sequential Version Numbers" 

 XE "Version Number:Sequential"  and the official VistA version and patch number XE "Patch Numbers"  of all VistA software, including all executables, dynamic link libraries XE "Dynamic Link Libraries"  (.dll files XE "DLL Files" ), and compiled packages XE "Compiled Packages"  (.bpl files XE "BPL Files" ) shall be maintained internally within the application properties XE "Application Properties" .

3.1.1. VistA Version and Patch Numbers XE "Version Number:VistA Version and Patch Numbers" 

 XE "VistA Version and Patch Numbers" 

 XE "Patch Numbers" 
The official VistA version and patch number from the National Patch Module XE "National Patch Module"  on FORUM for the VistA application shall be viewable in the properties of the application XE "Application Properties"  as part of the Application Description XE "Application Description" .

Example: 1.2. Patch 14

3.1.2. Sequential Version Numbers XE "Sequential Version Numbers" 

 XE "Version Number:Sequential" 

 XE "Sequential Version Numbers" 
The module version number of all VistA software shall be in industry standard format XE "Industry Standard Format:Version Numbers" 

 XE "Version Number:Industry Standard Format"  and viewable in the properties of the application XE "Application Properties"  as the File Version XE "File Version" .

Example: 1.2.13.456

3.1.2.1. Set version number property in Delphi. XE "Set Version Number Property in Delphi" 

 XE "Delphi:Set Version Number Property" 

 XE "Version Number:Set Property in Delphi" 
The module version number viewable in a file's properties is a string of four numbers delimited by periods.

3.1.2.1.1. The first number, called "Major Version XE "Delphi:Major Version Number" 

 XE "Major Version Number" 

 XE "Version Number:Major Version Number" ," shall contain the whole number portion of the VistA version number.

3.1.2.1.2. The second number, called "Minor Version XE "Delphi:Minor Version Number" 

 XE "Minor Version Number" 

 XE "Version Number:Minor Version Number" " shall contain the decimal portion of the VistA version number.

3.1.2.1.3. The third number, called "Release XE "Delphi:Release Number" 

 XE "Release Number" 

 XE "Version Number:Release Number" " shall be incremented at the discretion of the development team.

3.1.2.1.4. The fourth number, called "Build XE "Delphi:Build Number" 

 XE "Build Number" 

 XE "Version Number:Build Number" ", shall be incremented sequentially at the discretion of the development team.

3.1.3. About Box XE "About Box" 
Both the industry standard sequential version number XE "Version Number:Sequential" 

 XE "Sequential Version Numbers" 

 XE "Industry Standard Format:Version Numbers" 

 XE "Version Number:Industry Standard Format"  and the official VistA version and patch numbers XE "VistA Version and Patch Numbers" 

 XE "Patch Numbers"  shall be displayed in the VistA application's About box.

3.2. Package Installations XE "Package Installations" 

 XE "Package Installations" 
3.2.1. Package installations shall allow for installation of VistA applications on a client and/or application server.

3.2.2. VistA application, help files XE "Help Files" , and any other files, shall be imbedded in an executable installation package XE "Executable Installation Package" .

3.2.3. The executable installation package XE "Executable Installation Package"  shall insure that the various files are stored under the correct user-specified directories (see the "Namespacing" standard for the default directory).

3.2.4. The executable installation package XE "Executable Installation Package"  shall generate any standard shortcuts XE "Shortcuts" , program folders XE "Program Folders" , etc. for the package.

3.2.5. The executable installation package XE "Executable Installation Package"  shall perform any other file registrations XE "File Registrations"  required for the package.

3.2.6. The executable installation package XE "Executable Installation Package"  shall provide the capability to save any replaced files in a backup or similar folder.

3.2.7. The executable installation package XE "Executable Installation Package"  shall provide the capability to uninstall the VistA application XE "Uninstall the VistA Application" 

 XE "VistA Application:Uninstall" .

4. Look and Feel

4.1. Basic Form Controls XE "Basic Form Controls" 
4.1.1. Sizing Forms

4.1.1.1. All VistA applications shall support a minimum screen resolution as referenced in the "Operating Systems" standard.

4.1.1.2. When a non-modal form allows resizing, it shall include both a minimize and maximize button.

4.1.1.3. A modal form shall not allow minimizing.

4.1.1.4. When resizing is allowed, all the visual components must remain accessible when the window is reduced (i.e., no lost buttons, scroll bars, menus, etc.).

4.1.1.5. When resizing is allowed, the form shall include the standard Windows sizing Control menu as shown below:
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Figure 1: Sample Control Menu

4.1.2. Closing forms XE "Closing forms" 
4.1.2.1. Each form shall have at a minimum, two ways to close the form, one being the shortcut Close Alt+F4 on the Control menu and the other being the 
[image: image3.png]


 in the upper right corner of the form.

4.1.3. Color

4.1.3.1. All text and visual components shall remain visible, if the application is using a hard coded color not derived from the Windows color scheme.

4.1.3.1.1. If the VistA application is using a hard coded font color not derived from the Windows color scheme, the background shall also be hard coded.

4.1.3.1.2. If the VistA application is using a hard coded background color not derived from the Windows color scheme, the font shall also be hard coded.

4.1.3.2. Color shall not be used as the only means of conveying important information.

4.1.4. Fonts XE "Fonts" 
4.1.4.1. VistA applications shall use only standard Microsoft Windows fonts.

4.1.4.2. A single proportional font type shall be used throughout the VistA application. The exception to this standard is any component/control utilizing character-based word-processor fields shall use only a non-proportional font.

4.2. Menus XE "Menus" 
4.2.1. All menus in VistA applications shall provide keyboard accelerators.

4.2.2. Options shall be grayed out and not removed when their functionality is not supported within the current context. The exception to this standard is options available only to privileged users may be removed from the menu of non-privileged users, if this functionality will never be available to the non-privileged users in any part of the VistA application.

4.2.3. All VistA applications that utilize a Menu bar shall include File and Help menus on the Menu bar.

4.2.4. All VistA applications shall list menu bar options in the following relative order, from left to right:

	Menu Bar Item
	Required
	Order

	File
	Yes
	1

	Edit
	No
	2

	View
	No
	3

	Application-specific Menu Item(s)
	No
	3+n

	Tools
	No
	Second to Last

	Help
	Yes
	Last


4.2.5. File Menu

4.2.5.1. All VistA applications shall provide a File menu.

4.2.5.2. VistA applications primary options such as New, Open, Save, Save As, Send To, Print, Page Setup, Print Preview, Close, Exit, or similar options shall be placed on the File menu.

4.2.5.3. The File menu shall provide at a minimum, a VistA application Exit menu item.

4.2.6. Edit Menu

4.2.6.1. VistA applications general purpose editing options such as Cut, Paste, Copy, Delete, or similar options shall be placed on the Edit menu.

4.2.7. View Menu

4.2.7.1. VistA application options such as Zoom, Toolbar, Status bar, and similar options that allow the user to customize their view of the data or form shall be placed on the View menu.

4.2.8. Tools Menu

4.2.8.1. VistA application options such as Options, Customize, Configuration Items, User Interface Setup, or similar options that provide for utilities or personal preferences shall be placed on the Tools menu.

4.2.9. Help Menu

4.2.9.1. All VistA applications shall provide a Help menu.

4.2.9.2. VistA applications online help options such as Contents, About, Show, What's This, Online Tutorials, or similar options shall be placed on the Help menu.

4.2.9.3. The Help menu shall provide at a minimum, Contents and About options.

4.2.9.3.1. The first option on the menu shall be Contents.

4.2.9.3.2. The last option on the menu shall be About or About "application name".

4.2.10. Pop-up Menus

4.2.10.1. If pop-up menus are used, they shall provide options consistent with the context of the item selected.

4.2.10.2. Any options displayed on this menu and not applicable at the time the menu is accessed, shall be grayed out and not removed.

4.3. Mouse Actions XE "Mouse Actions" 
4.3.1. Right Button: This button shall activate pop-up menus, if they are present.

4.3.2. Middle Button: This button shall never be used for any VistA application.

4.3.3. Left Button: This button shall be used for standard Microsoft Windows mouse actions such as single and double clicking, press and drag, control click, and shift click.

4.4. Status Bar XE "Status Bar" 
4.4.1. If used, the Status bar shall not be used as the only means of conveying VistA application important information.

4.5. Form Contents XE "Form Contents" 
4.5.1. All functions in a VistA application shall be accessible by both mouse click action and keyboard accelerator. The exceptions to this standard are text entry and graphical functions such as drawing.

4.5.2. Actions that could have significant consequences (i.e. irreversible or destructive changes) shall present the user with a confirmation prompt and require explicit selection of the desired action.

4.5.2.1. The confirmation prompt shall provide a non-destructive or cancel function.

4.5.2.2. If a default selection is used, the non-destructive option shall be designated as the default.

4.5.3. If a process requires a user to wait until its completion before proceeding, the VistA application shall provide continuous visual feedback for the duration of the process.

4.5.4. All single and double clicking actions shall be consistent throughout an application.

4.5.4.1. Single clicking shall be used for the selection of an item in a list.

4.5.4.2. Double clicking on an item in a list shall be used for the selection and performance of the default action.

4.5.5. All input controls shall be descriptively labeled.

Example:
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Figure 2: Sample Combo Box with Label
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5. On-Line Help

In this standard, "online help" refers not only to a Windows help file, but includes other types of user assistance.

Online help can consist of simple text files and error messages, wizards, online tutorials, What's This? help, ToolTips, status bar messages, and Windows-type Help files. Because the technology for both software and help is evolving rapidly, these standards do not specify authoring tools or industry standards, and the standards shall not restrict development in new technologies. Primarily, the standards apply to help that is available from a help menu. These standards do not apply to print documentation that is delivered online (e.g., Portable Document Format, or .pdf, documents retrieved via the web or from anonymous servers).

5.1. Application Help XE "Application Help" 
5.1.1. All VistA applications shall provide online Help.

5.2. F1 Key

5.2.1. All VistA applications shall use the F1 key to bring up the VistA application online Help.

5.3. Help Menu

5.3.1. VistA Applications that utilize a menu bar shall provide a Help menu.

5.3.2. Help Menu Required Information

5.3.2.1. The Help menu shall be the menu located furthest to the right on the menu bar as shown in the graphic below:
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5.3.2.2. The application online help shall be the first menu item on the Help menu (see 1.3.3 Sample Help Menus).

5.3.2.3. The About selection shall be the last menu item on the Help menu (see 1.3.3 Sample Help Menus

). Selecting this menu item will bring up the About box.

5.3.2.4. The Help menu shall only contain help related items (see 1.3.3 Sample Help Menus

).

5.3.3. Sample Help Menus

These examples visually represent the concepts discussed in sections 1.2.2.2-1.2.2.4.

The CPRS Help menu:
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The NOIS Help menu:
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The Microsoft Word 2000 Help menu:
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5.4. About Box Standards

5.4.1. All VistA applications shall include an About box.

5.4.2. All About boxes shall be dialog boxes.

5.4.3. All About boxes shall provide a Title bar with a Close button ( [image: image9.png]


 ) in the upper right corner. For example:
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5.4.4. The About box shall include a Close button (although the button caption may be Close, OK, or other appropriate text). For example:
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5.4.5. Required Information

5.4.5.1. Application Name

5.4.5.1.1. The application name or acronym shall be located in the left side of the About box Title bar after the word "About".

Example: About CPRS

5.4.5.1.2. The complete application name with all acronyms spelled out shall appear in the main text area of the About box.

Example: Computerized Patient Record System (CPRS)

5.4.5.2. Module Version Number

All About boxes shall display the application's module version number using the format described in the standard (Release of Software).

Example: Module Version = 1.2.7.4
5.4.5.3. Server Version Number

All About boxes shall display the application's server version number.

Example: Server Version = 1.3

5.4.5.4. Client Patch Number

If the executable is released as part of a patch, the client patch number associated with the VistA application shall be clearly displayed.

5.4.5.5. Server Patch Number

The current server patch number associated with the VistA application shall be clearly displayed.

5.4.6. Compiled Date

5.4.6.1. The developer shall place the last date the executable was compiled in the About box prior to delivery to the field for testing or release.

5.4.6.2. The date shall consist of a month, day, and year and shall be displayed in one of the following formats:

· January 25, 2000

· Jan. 25, 2000

· 01/25/2000

5.4.6.3. Cyclic Redundancy Check (CRC) Number

5.4.6.3.1. A CRC-32 number shall be displayed in the About box using the GetFileCRC32 method in the Xlffileinfo unit. An example of a CRC can be found in the CPRS About box (see 1.4.7 Sample About box).

5.4.6.4.  Source Information

5.4.6.4.1. The following statement shall be included in the About box:

"Developed by the Department of Veterans Affairs."

5.4.6.5. Privacy/Security Message

5.4.6.5.1. The following statement shall be included in the About box:

"Unauthorized access or misuse of this system and/or its data is a federal crime. Use of all data shall be in accordance with VA policy on security and privacy."

5.4.7. Sample About Box XE "Sample About Box" 
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5.5. ToolTips

5.5.1. A ToolTip shall be provided for each unlabeled icon that invokes an action.

The following graphic shows an example of a ToolTip that is displayed when a user moves the cursor over the printer icon.
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5.5.2. Component/Control Help

5.5.2.1. Custom components/controls shall provide design-time online documentation/help (e.g., a text file, help file, or by some other method).

5.5.2.2. Visual custom components/controls for inclusion in VistA applications shall provide user online help (e.g., a help file, tooltip, or some other method).

<This page intentionally left blank for double-sided printing.>

6. Source Code

6.1. Delphi Source Code XE "Delphi Source Code" 
6.1.1. Header Comments

6.1.1.1. Specific header comment information shall be utilized.

6.1.1.2. Specific header comment information shall be placed at or near the top of each file(s), unit(s), etc. that contains source code within the VistA application.

6.1.1.3. Header comment information shall be presented in the following sequence using the highlighted keywords:

Package: NAMESPACE – PACKAGE

This shall be the assigned VistA package namespace and package name. (The spaces between the namespace "-" package are optional).

WARNING: "Per VHA Directive xxxxxx this unit should not be modified."

This comment shall only be included when applicable.

Date Created: This shall be the initial release date of the file or unit.

Site Name: This shall be the Office from which the file or unit was initially released.

Developers: This shall identify the developer(s) responsible for the file or unit.

Description: This shall be a brief description of the main purpose of this file or unit.

Note: Special notes may be placed in this section (optional).

Example of Header Comments:


Package: XWB – Kernel Broker


WARNING: Per VHA Directive 10-93-142 this unit should not be modified.


Date Created: Jan 1, 2000


Site Name: Birmingham, OIFO


Developers: John Smith, Jill Brown


Description: Broker Library utilities.


Note: This unit requires XU*1*999 in order to run.

6.1.2. Scoping XE "Scoping" 
6.1.2.1. Variables, functions, procedures, classes, types, and constants intended for use within a given structure (classes, units, functions, procedures) shall be scoped to the lowest possible level for the given structure.

6.1.3. Constants XE "Constants" 
6.1.3.1. Constants shall be used to represent static values, regardless of type. The exception to this standard is single-use string values.

6.1.3.2. A constant shall be descriptively named.

6.1.4. File Path Specification

6.1.4.1. If using a file that will be located by the operating system (e.g., dlls) and that file is not in the System32 directory, a relative path shall be defined that identifies the file location.

Example: Function MyFunc; external  '\Program file\Vista\Common Files\NameSpaceTEST.DLL';

Example:  Function MyFunc; external  '..\Common Files\PCMMTEST.DLL';

6.1.4.2. Modification of the environment path shall be prohibited.

6.1.5. White Space

6.1.5.1. The space character shall be used for white space within text source files.

6.1.5.2. Use of Tab character is prohibited.

6.1.6. Variable Types

6.1.6.1. Variables representing server data shall be type compatible with possible extreme values of that data.

Example: Any variable representing an IEN or DFN should be declared as a string.

6.1.7. Naming Standards XE "Naming Standards" 
6.1.7.1. Units

6.1.7.1.1. The first character of a unit name shall be descriptive of the unit's contents.

6.1.7.1.2. Unit Names shall begin with a lowercase, one character letter, followed by the namespace, followed by a mixed case descriptive name.

6.1.7.1.3. These characters are reserved for the following uses:

A. "f" + Namespace + Descriptive Name—"f" shall be used for units that define a form class.

B. "d" + Namespace + Descriptive Name—"d" shall be used for units that define a data module class.

C. "m" + Namespace + Descriptive Name—"m" shall be used for units that define a frame class.

D. "r" + Namespace + Descriptive Name—"r" shall be used for units that define additional user created resource files.

E. "u" + Namespace + Descriptive Name—"u" shall be used to define standalone units.

Other prefix characters may be used at the developer's discretion.

6.1.7.1.4. Generated Class Names

6.1.7.1.4.1. For classes that automatically create a unit, descriptive names between the classes and their units shall be consistent. Furthermore, the name property of the following classes shall be assigned the following prefixes:

Delphi forms shall begin with a lowercase, three-character string "frm" followed by a descriptive name.


"frm" + Descriptive Name—"frm" indicates this is a form

Delphi data modules shall begin with a lowercase, two-character string "dm" followed by a descriptive name.


"dm" + Descriptive Name—"dm" indicates this is a data module

Delphi frames shall begin with a lowercase, three-character string "fra" followed by a descriptive name.


"fra" + Descriptive Name—"fra" indicates this is a frame

6.1.7.1.5. Types and Field Names

6.1.7.1.5.1. Class, type, exception, interface, and field names shall begin with an uppercase, one character letter followed by a descriptive name.

6.1.7.1.5.2. The following characters shall be used:

"T" + Descriptive Name—"T" is for the standard class or type

"E" + Descriptive Name—"E" is for an exception.

"I" + Descriptive name—"I" is for interface.

"F" + Descriptive Name—"F" is for class field name

6.1.7.1.6. Enumerated Type Names

6.1.7.1.6.1. Enumerated type names shall be descriptive of the intention of the enumeration.

6.1.7.1.6.2. The entries of the type shall begin with a lowercase two or more character prefix that relates it to the original type.

Example: TCardType = (ctClub, ctDiamond, ctSpade, ctHearts)

6.1.7.1.7. Property Access Method Names

6.1.7.1.7.1. Property Read and Write methods, if used, shall be named "GetPropertyName" and "SetPropertyName" respectively.

6.1.7.1.8. Component Names

6.1.7.1.8.1. The following table is organized by Tabs from a default Delphi Component palette. Within each Tab, the components that are or will be used within the VA are assigned a prefix naming standard. If any component is derived from one of these standard components the naming standard shall be applied to the new component unless specifically stated otherwise. Any package specific component shall also follow the naming standards set forth here. Any component not referenced or descended from a component in the following table will need to be reviewed with the GUI SACC as the need arises.

	Delphi Component Palette Tab
	Naming Standard Prefix
	Types of Components Affected

	Standard
	
	

	
	fra
	Descendants of TFrame

	
	mnu
	TMainMenu, TPopupMenu, TmenuItem (Separator menu items do not need to follow this standard if there are no coding references or events)

	
	lbl
	TLabel

	
	edt
	TEdit

	
	mem
	TMemo

	
	btn
	TButton,

	
	chk
	TCheckBox

	
	rbtn
	TRadioButton

	
	lst
	TListBox

	
	cbx
	TComboBox

	
	sbr
	TScrollBar

	
	grp
	TGroupBox

	
	rgrp
	TRadioGroup

	
	pnl
	TPanel

	
	
	

	Additional
	
	

	
	btn
	TBitBtn, TSpeedButton

	
	edt
	TMaskEdit

	
	grd
	TStringGrid, TDrawGrid

	
	img
	TImage

	
	shp
	TShape

	
	bvl
	TBevel

	
	sbx
	TScrollBox

	
	lst
	TCheckListBox

	
	splt
	TSplitter

	
	lbl
	TStaticText

	
	cbr
	TControlBar

	
	app
	TApplicationEvents

	
	chrt
	TChart

	
	
	

	WIN 32
	
	

	
	tbctrl
	TTabControl

	
	pgctrl
	TPageControl

	
	tbsht
	TTabSheet

	
	imglst
	TImageList

	
	mem
	TRichEdit

	
	trkbr
	TTrackBar

	
	prgbr
	TProgressBar

	
	spn
	TUpDown

	
	htky
	THotKey

	
	anm
	TAnimate

	
	dtpkr
	TDateTimePicker

	
	cal
	TMonthCalendar

	
	tvw
	TTreeView

	
	lvw
	TListView

	
	hdr
	THeaderControl

	
	stsbr
	TStatusBar

	
	tlbr
	TToolBar

	
	clbr
	TCoolBar

	
	pgscrl
	TPageScroller

	
	
	

	System
	
	

	
	tmr
	TTimer

	
	pbx
	TPaintBox

	
	mplr
	TMediaPlayer

	
	ole
	TOleContainer

	
	dde
	TDdeClientConv;TDdeClientItem; TDdeServerConv;TDdeServerItem

	
	
	

	Dialogs
	
	

	
	dlg
	This shall be used for all components under the dialogs tab.

	
	
	

	Win 3.1
	
	

	
	tbst
	TTabSet

	
	tvw
	TOutline

	
	tbnbk
	TTabbedNotebook

	
	nbk
	TNotebook

	
	hdr
	THeader

	
	lst
	TFileListBox;TDirectoryListBox

	
	cbx
	TDriveComboBox;TFilterComboBox

	
	
	

	Samples
	
	

	
	gauge
	TGauge

	
	clrgrd
	TColorGrid

	
	spn
	TSpinButton

	
	spnedt
	TSpinEdit

	
	tvw
	TDirectoryOutline

	
	cal
	Calendar

	
	
	

	ActiveX
	
	

	
	xchrt
	TChartfx

	
	xspl
	TVSSpell

	
	xbook
	TF1Book

	
	xchrt
	TVtChart

	
	
	

	Server
	
	

	
	srvr
	This shall be used for all components under the server tab.

	
	
	

	Kernel
	
	

	
	brkr
	TRPCBroker

	
	
	

	FileMan
	
	

	
	dlg
	TFMLookup

	
	dbs
	TFMLister, TFMGets, TFMValidator, TFMFiler, TFMHelp, TFMFinder, TFMFindOne

	
	edt
	TFMEdit

	
	mem
	TFMMemo

	
	lst
	TFMListBox

	
	cbx
	TFMComboBox, TFMComboBoxLookup

	
	rbtn
	TFMRadioButton

	
	rgrp
	TFMRadioGroup

	
	chk
	TFMCheckBox

	
	lbl
	TFMLabel

	
	
	

	CPRS
	
	

	
	cbx
	TORComboBox


6.1.7.1.8.2. A descriptive component name shall be used.

The following are examples of the component naming standard:

<standard prefix>+Descriptive Component Name

Example: btnOK

Example: btnCancel

6.1.7.2. Destructors

6.1.7.2.1. All class destructors shall be named "Destroy".

6.1.7.2.2. All class destructors shall override the TObject.Destroy virtual destructor.

6.1.7.2.3. The methods Free or Release shall be used to destroy objects.

6.1.7.2.4. Destructors shall not be explicitly called.

6.1.8. Resource Protection

6.1.8.1. All resources intended for use within a given structure (e.g., applications, dlls, classes, units, functions, procedures) shall be claimed, and returned to their appropriate state, at the lowest possible level for the given structure. This includes (but is not limited to):

A. Freeing all allocated memory, including the destruction of created objects, components, and forms.

B. Appropriate termination of communications with external dlls, COM objects, applications, printers and other devices, server connections, networked PCs, interface references, and database connections.

C. Closing opened or created files.

D. Deleting temporary files.

E. Releasing explicitly allocated Windows resources.

6.1.8.2. A resource that is claimed within the same procedure, function, block of code, shall be done so with a Try Finally block structure.

Example:

Reset(F);

try

 ... // process file F

finally

  CloseFile(F);

end;

6.1.8.2.1. In cases where the claim on the resource may be in question, conditional constructs shall be used within the Finally block:

Example:

obj := nil;

if NeedObject then

  obj := TMyObject.Create;

try

  …

finally

  if(assigned(obj)) then

    obj.free;

end;

6.1.9. Error handling

6.1.9.1. Errors explicitly generated by the application shall be sufficiently descriptive to identify where the error has occurred.

6.1.9.2. Trapping for errors shall be error specific, to prevent the masking of unexpected errors.

Example:

CORRECT:

Try 

  MyRPCBroker.Call;

except

  on E:EBrokerError do

  begin  

    Showmessage('Broker Error: ' + E.Message);

    LogBrokerError(E);

  end;

  on E:EAccessViolation do

    Showmessage(E.Message);

  else

    raise;

end;
INCORRECT:

try

  MyRPCBroker.Call;

except

  showmessage('Broker Error');

end;
6.1.10. Compilation Requirements

6.1.10.1. Software applications and components shall compile with no errors, warnings, or hints. This requirement does NOT apply to any third-party software, which may be within the application.

6.1.10.2. The compiler shall be set to show hints and warnings.

6.1.11. Nationally Supported GUI Software Components

6.1.11.1. Modifying the behavior of any supported component, through inheritance or modification of source code, shall have an Integration Agreement (IA).

6.1.11.2. Interception of Windows messages to an application or supported component through sub-classing or other means for the purpose of either modifying the data or extracting sensitive data shall be prohibited.

6.1.11.3. Source code that must not be altered shall be labeled accordingly in header comments.

6.1.11.4. Backward and Forward Compatibility

6.1.11.4.1. Nationally supported VistA components shall conform to the policies set by VistA Data Systems Integration (VDSI).

6.1.11.5. Third Party Software

6.1.11.5.1. Nationally supported VistA software that specifically uses third party software shall be responsible for the behavior of the third party software.

6.2. Design/Architecture

6.2.1. Command line parameters

6.2.1.1. S or SERVER shall be reserved for references to the name or IP address of the VistA server computer.

6.2.1.2. P or PORT shall be reserved for references to the Listener port on the VistA server computer.

6.2.1.3. Command line parameters shall not be used as a means of user authentication.

6.2.2. Client Data Storage

6.2.2.1. Temporary files shall have a unique name among multiple instances of the same VistA application.

6.2.3. Third Party Software

6.2.3.1. All VistA application developers using third party software shall be responsible to ensure that the scope of any licensing for the third party software matches the scope of the application.

6.2.3.2. Any third party components used in VistA development shall be registered with the DBA.

6.2.4. Connection Authentication

The application user authentication method for accessing the VistA system shall be approved by the Software Engineering Process Group (SEPG).

6.3. MUMPS Standards Relating to GUI Development

6.3.1. VA Remote Procedure Calls (RPC)

6.3.1.1. All RPCs provided for use outside the development domain (i.e., for use by non-custodian applications) shall be registered in the Integration Agreement (IA) database. This applies to Supported (i.e., public), Controlled Subscription, and Private RPCs.

6.3.1.2. Designation of the RPC as to type (e.g., Supported) shall be required to be included in the IA database.

6.3.1.3. All approved IAs shall be assigned a reference number.

6.3.1.4. RPCs shall be documented in the VistA REMOTE PROCEDURE file (#8994). This file includes a designation of the AVAILABILITY field (#.05), which corresponds to the usage field in the Integration Agreement (IA) database, as follows:

Integration Agreement Usage
RPC Availability

=======================
=============

Supported
Public

Controlled Subscription
Subscription

Private
Agreement

----
Restricted

RPCs designated as Restricted are for internal use within a given package, and do not require an Integration Agreement (IA).

6.3.1.5. Entries in the Remote Procedure file (#8994) shall include detailed documentation.

6.3.1.5.1. The Description field (#1) shall include a brief description of the function/services of these entries, including a description of business rules supported by the RPC and an example for use of the RPC.

6.3.1.5.2. The Input Parameter Description field (multiple file #8994.02, field #1) shall include a description of the input values and types.

6.3.1.5.3. The Return Description field (#3) shall include return values, including global array and word-processing return value types.

6.3.1.6. Maintenance and support of nationally supported RPCs shall follow the M SAC standards governing supported references. Use of Subscription or Agreement RPCs shall be pre-approved in the Integration Agreement (IA) database.

6.3.1.7. Designation of assigned IA number shall be documented in the Description field (#1) of the RPC within the VistA Remote Procedure file (#8994).

Source Code Conventions

6.4. Language Independent Conventions

6.4.1. Readability

The following are recommended:

6.4.1.1. No more than one statement per line.

6.4.1.2. A two-space indentation level.

6.4.1.3. At least one blank line between procedures, functions, methods, class and interface declarations, and other common block structures.

6.4.1.4. Capitalize the first letter of each word in variable, procedure, and other names (a.k.a. Camel Caps or InfixCaps). Example: ThisIsCamelCaps.

6.4.1.5. Constant names should be in all uppercase.

6.4.1.6. Reserved words should be in all lowercase.

6.4.1.7. Use of descriptive names.

6.4.1.8. Descriptive comments are encouraged for complex procedures and methods.

6.4.2. Use of resources

Forms and objects should be created and destroyed on an as needed basis. Creating numerous forms and objects upon program startup that are not immediately needed is strongly discouraged.

6.4.3. Separation of functionality from user interface.

When possible, it is desirable to have a clear separation between general program tasks, and the user interface to those tasks. This allows for multiple places within an application to perform a given function, and also facilitates the exportation of that function to other applications.

6.4.4. Third Party Software

Careful consideration is recommended before use of any third party software in VistA applications.

When possible, source code should be obtained for third party software. Use of licensed, supported third party software is encouraged. Use of freeware, non-supported or unlicensed software is strongly discouraged.

6.4.5. Nationally Supported

6.4.5.1. When possible, nationally supported software should be written in the form of a class.

6.4.5.2.  It is recommended that nationally supported software classes use virtual methods to facilitate class inheritance.

6.4.5.3. Modifications to supported software should be in the form of class inheritance.  This allows modifications to the supported software to be reflected in the inherited class.

6.5. Language Specific Conventions

6.5.1. Delphi

6.5.1.1. Readability

6.5.1.1.1. Except for IDE generated code, the scoping directive for a class should be declared in the following order.

· Private

· Protected

· Public

· Published

6.5.1.1.2. Within a given scope, class declarations should be declared in the following order:

· Fields

· Methods

· Properties

6.5.1.1.3. All methods of a given class should be grouped together in the Implementation section of a Unit. Constructors and Destructors should be placed at the top of the class implementation.

6.5.1.1.4. The (* … *) comment structure should be reserved for commenting out blocks of code.

6.5.1.2. Use of resources

It is strongly recommended that only the main form of an application be Auto created.

6.5.1.3. General Coding Standards

6.5.1.3.1. Use of enumerated types is strongly recommended over defining related constant values. Enumerated types provide type checking at compile time.

Example:

Recommended: TCardType = (ctClub, ctDiamond, ctSpade, ctHeart)

Not Recommended:

const


CLUB = 0;


DIAMOND = 1;


SPADE = 2;


HEART = 3;

6.5.1.3.2. The program name of the currently running executable should be obtained using Application.ExeName or ParamStr(0).

6.5.1.4. Constants

Use of Delphi typed constants are not recommended, expect in cases where static local variables are needed. Pre-initialization of global typed variables can be accomplished in a variable declaration.

6.6. Mumps Conventions related to GUI development

6.6.1.1. It is recommended that user specific preferences should be stored on the server, allowing preferences to follow the user between workstations.

6.6.1.2. It is strongly recommended that applications store configuration data in the KERNEL PARAMETER file (#8989.5).
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